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Summary 
A comprehensive laboratory protocol and analysis workflow is described for a rapid, cost effective 
and straight forward colorimetric cell-based assay for the detection of neutralizing elements against 
AAV6. 
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Abstract 
Recombinant adeno-associated viruses (rAAV) have proven to be a safe and successful vector for the 
transfer of genetic material to treat a variety of health conditions in both the laboratory and the 
clinic. However, the presence of pre-existing neutralizing antibodies (NAbs) against AAV capsids 
poses an ongoing challenge for the successful administration of gene therapies in both large animal 
experimental models and human populations. Preliminary screening for host immunity against AAV 
is necessary to ensure the efficacy of AAV-based gene therapies as both a research tool and as a 
clinically viable therapeutic agent. This protocol describes a colorimetric in vitro assay to detect 
neutralizing factors against AAV serotype 6 (AAV6). The assay utilizes the reaction between an AAV 
encoding an alkaline phosphatase (AP) reporter gene and its substrate NBT/BCIP, which upon 
combination generates an insoluble quantifiable purple stain.  

In this protocol serum samples are combined with an AAV expressing AP and incubated to permit 
potential neutralizing activity to occur. Virus serum mixture is subsequently added to cells to allow 
for viral transduction of any AAVs that have not been neutralized. The NBT/BCIP substrate is added 
and undergoes a chromogenic reaction, which corresponds to viral transduction and in turn the 
neutralizing activity. The proportion of area colored is quantitated using a free software tool to allow 
for the generation of neutralizing titers. This assay displays a strong positive correlation between 
coloration and viral concentration. Assessment of serum samples from sheep both prior to and 
following administration of a recombinant AAV6 led to a dramatic increase in neutralizing activity 
(125 to >10,000-fold increase). The assay displayed adequate sensitivity to detect neutralizing 
activity in >1:32,000 serum dilutions. This assay provides a simple, rapid and cost-effective method 
to detect NAbs against AAVs. 
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Introduction 
Adeno-associated viruses (AAV) are increasingly used as vectors for the delivery of gene therapies to 
trial treatments for a variety of health conditions that impact the cardiovascular, pulmonary, 
circulatory, ocular and central nervous systems1-5. The popularity of AAV vectors as a leading gene 
therapy platform stems from their positive safety profile, long-term transgene expression and wide-
ranging tissue specific tropisms1,6. Successful outcomes in animal studies have paved the way for 
over fifty AAV gene therapy clinical trials that have successfully reached their efficacy endpoints7, as 
well as release of the first commercially available AAV gene therapy drug approved by the US Food 
and Drug Administration8.  Following initial successes, AAV have continued to gain traction in both 
the basic and clinical research sectors as a vector of choice and are currently the only in vivo gene 
therapy approved for clinical use in the US and Europe9. Nonetheless, the presence of pre-existing 
neutralizing antibodies (NAbs) against AAV vector capsids remains a hindrance to both preclinical 
research, and the efficacy of clinical trials. NAbs are present in both naïve human and animal 
populations and inhibit gene transduction following in vivo administration of an AAV vector1. AAV 
seropositivity is an exclusion criterion for most gene therapy trials and therefore preliminary 
screening for host immunity is crucial in both the laboratory and the clinic. Establishing an assay that 
can detect the presence of NAbs against AAV is an essential step in the pipeline of any AAV gene 
therapy-based research project. This report focuses on AAV6 which has been of interest to 
researchers due to its efficient and selective transduction in striated muscle (heart and skeletal 
muscle)1,10-12. Gene therapy is considered a promising strategy for targeting the heart because it is 
difficult to specifically target the heart without invasive open-heart procedures. 

Neutralizing activity is usually determined using either a cell-based in vitro or in vivo transduction 
inhibition assay. In vivo NAb assays usually involve administering serum from a test subject (e.g., 
human or large animal) into mice, followed by an AAV with a reporter gene, followed by testing for 
the expression of the reporter gene or corresponding antigen. In vitro assays determine NAb titers 
by incubating serum or plasma from a human or large animal in serial dilutions with a recombinant 
AAV (rAAV) that expresses a reporter gene. Cells are infected with the serum/virus mixture and the 
extent to which the expression of the reporter gene is inhibited is assessed compared with controls. 
In vitro assays are widely used for NAb screening due to their comparatively lower cost, rapidity in 
testing and greater capacity for standardization and validation13,14 compared with in vivo assays. In 
vivo assays are often reported to have greater sensitivity15,16, but the same claim has been made 
with respect to in vitro assays14,17.  

To date, in vitro NAb assays have mostly used luminescence (luciferase) as the reporter gene to 
detect neutralization, and although a light-based method has merit in many contexts, a 
colorimetric/chromogenic NAb assay may be more advantageous in some circumstances. 
Colorimetric assays to assess neutralization have been successfully employed for other viruses such 
as influenza and adenovirus18,19. Their attractiveness stems from their simplicity, lower cost and the 
requirement for only everyday laboratory apparatus and tools20. NAb assays that use a luminescence 
based reporter gene have the additional requirement of costly substrate kits, a luminometer and 
corresponding software for analysis21. This colorimetric assay has the advantage of only requiring a 
light microscope and a very cheap substrate. Reporting of the sensitivity of colorimetric verses 
luminescent assays has yielded conflicting results. One study suggested luminescence based ELISA 
assays display greater sensitivity and comparable reproducibility to colorimetric assays22, whilst 
another study found colorimetric based ELISA assays to confer greater sensitivity23. Here, a detailed 
protocol for an in vitro NAb assay against AAV that utilizes the chromogenic reaction between an 
AAV encoding an alkaline phosphatase (AP) reporter gene and a nitro blue tetrazolium /5-bromo-4-
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chloro-3-indolyl phosphate (NBT/BCIP) substrate is provided. This step-by-step protocol was 
developed based on a previous report that utilized a hPLAP (human placental alkaline phosphatase) 
reporter gene (AAV6-hPLAP) for the detection of neutralizing activity against AAV24. This assay is cost 
effective, time efficient, easy to set up and requires only minimal technical skills, laboratory 
equipment and reagents. Moreover, the simplicity of this assay gives it the potential to be optimized 
for broad application across different types of cells, tissues or viral serotypes.    

 

Protocol 
All aspects of animal care and experimentation were conducted in accordance with Florey Institute of 
Neuroscience and Mental Health guidelines and the Australian Code for the Care and Use of Animals 
for Scientific Purposes (National Health and Medical Research Council of Australia, 8th edition, 2013). 
 
A schematic overview of the assay protocol is provided in Figure 1.  [Place Figure 1 here] 

1. Initial preparation 
 
1.1. For assessment in sheep: Collect blood in 8mL serum separator clot activator tubes, leave 

the blood sample at room temperature (RT) for 20-30 minutes and subsequently spin down 
at 2100 g for 15 minutes. The clear supernatant that forms at the top of the tubes is serum. 
Aliquot the clear aqueous phase into microcentrifuge tubes and store at -80°Celcius (C). 
NOTE: Blood was collected from the carotid vein using a 16-gauge needle (tip cut-off) and 
syringe from conscious 1.5-3 year old Merino ewes.  
 

1.2. Heat inactivate fetal bovine serum (FBS) by placing it in a water bath at 56°C for 30 minutes 
and swirling intermittently. For precision, place a thermometer in a second bottle 
containing an equivalent volume of water and add it to the heat bath at the same time as 
the FBS bottle. Begin timing when the thermometer reaches 56°C. 

 
 

1.3. Employ proper aseptic technique and cell culture practice for all subsequent steps that are 
performed in the cell culture hood 25,26. Spray all objects and the hood itself with 70% 
ethanol prior to use and clean with 1% sodium hypochlorite upon completion.  
 

1.4. Make complete Dulbecco's Modified Eagle Medium (DMEM) by combining high glucose 
(4.5g/L) DMEM (89%) with heat inactivated FBS (10%) and Penicillin Streptomycin (1%). 
Combine and filter using a sterile vacuum filtration (0.22 μm pore size, polyethersulfone 
membrane) system. Store complete DMEM wrapped in foil at 4°C. 

 
 

1.5. Establish HT1080 cells and passage in a 75cm2 square flask as described in AAV-HT1080 cell 
culture guidelines Catalog #240109 (https://www.chem-
agilent.com/pdf/strata/240109.pdf). Create multiple frozen stocks of cells. Do not use cells 
after 20 passages as further passaging may influence the assay results. 

 

2. Day 1 – Plating cells  
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2.1. Passage HT1080 cells until they reach ~80% confluency as described in the AAV-HT1080 cell 

culture guidelines Catalog #240109 (https://www.chem-
agilent.com/pdf/strata/240109.pdf). 
 

2.2. Pre-warm complete DMEM, 0.05% trypsin-EDTA and 1x phosphate buffered saline (PBS) to 
37°C in a water bath. Remove the growth medium from passaged cells using an aspiration 
system. NOTE: All aspiration in this protocol uses a vacuum system with a tube attached to 
a sterile 5 mL serological pipette. Wash the cells in 10 mL of pre-warmed (37°C) 1x PBS and 
trypsinize cells for 3-4 minutes in 4 mL of pre-warmed 0.05% trypsin-EDTA to detach the 
cells from the flask. Inactivate the trypsin by adding 6 mL of pre-warmed complete DMEM 
and pipette the cells into a 50 mL tube. Calculate the number and concentration of viable 
cells using a haemocytometer and the trypan blue exclusion method27. 
 

2.3. Dilute the cells to a concentration of 1x105 cells/mL in pre-warmed complete DMEM. Seed 
100 μl of cells/well into clear 96-well flat-bottomed plates (1x104 cells per well). Incubate 
the plate at 37°C, 5% carbon dioxide (CO2) overnight for 16-22 hours.  

 

3. Day 2 – Infecting cells 
 
3.1. Remove plate/s from the incubator and use a light microscope to visually confirm cells are 

evenly dispersed within the wells and the confluency is roughly 50%. If cells are not within a 
range of 45-55% confluency, repeat the ‘Day 1’ protocol and adjust initial cell concentration 
accordingly. 
 

3.2. Generate serial dilutions of the serum samples of interest in 1.5 mL microcentrifuge tubes 
using pre-warmed complete DMEM as the diluent. Table 1 demonstrates how to generate a 
dilution cascade for triplicate samples.  

 
 
To perform the assay in triplicate, prepare a 7.5x106 vector genomes (vg)/μl working 
solution of AAV6-hPLAP by diluting a virus stock solution in 1x PBS (a stock solution of 
AAV6-hPLAP can be provided upon request by A/Prof Paul Gregorevic, University of 
Melbourne, VIC, Australia, initial stock concentrations vary). Add 66 μl of the 7.5x106 vg/ μl 
virus working solution to each tube containing 264 μl of serum/media dilution (330 μl total 
volume/dilution, see Table 1). NOTE: This is a robust assay which does not require perfect 
culture conditions. However, to accurately quantitate and ensure each assay run is reliable, 
it is necessary to include: i) a no serum control, ii) a no serum or virus control, and iii) a NAb 
positive control sample on all plates under the same experimental conditions. 

 The volume described (330 μl) accounts for triplicate samples +10% of the serum & virus 
mixture. Performing replicates of the assay is highly recommended for accurate 
determination of neutralizing activity.  
 

3.3. Mix the virus/serum dilutions together by pipetting and place the tubes containing the 
virus/serum mixtures in an incubator at 37°C, 5% CO2 for 30 minutes to allow potential 
neutralization to occur.  
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3.4. Pipette 100 μl of the virus/serum mixture to each well on the 96-well plate containing 1x104 

cells/well for each dilution. This will generate a final viral concentration of 15k viruses/cell 
multiplicity of infection (MOI) in each well. Table 2 provides an example 96-well sample 
plate layout for assessing samples to a 1/512 dilution. 
 

3.5. Wrap the 96-well plate containing cells, serum and AAV-hPLAP in foil and place in an 
incubator at 37°C, 5% CO2 overnight for 16-24 hours to allow AAV entry into the cells.  
 
 

4. Day 3 - Fixing and adding substrate to cells 
 
4.1. CAUTION: Paraformaldehyde (PFA) is a probable carcinogen and is toxic from skin or eye 

contact or inhalation. Handle in a fume hood with proper personal protective equipment as 
well as a facemask. Make fresh 4% PFA diluted in PBS (~7 mL required per 96-well plate) 
and allow to cool to RT. 
 

4.2. Pre-warm an aliquot of PBS to 37°C (~25 mL/96-well plate). Cool separate aliquots of PBS 
(~25 mL/96-well plate) and double distilled H2O (DDW, ~25 mL/96-well plate) to 4°C. 
Dissolve a pellet of BCIP/NBT in 10 mL of DDW in a 50 mL conical centrifuge tube by 
vortexing (10 mL is enough for 2 x 96 well plates). 
 

4.3. Aspirate the media from the wells of the 96-well plate using a serological pipette or similar 
attached to a suction based aspiration system or fume hood vacuum. Gently place the tip of 
the serological pipette into the well and remove the media taking caution not to disrupt the 
adhered cells.  Add 50 μl of 4% PFA to each well using a pipette. Wrap the plate in foil and 
leave at RT for 10 minutes to fix the cells. 
 

4.4. Wash and aspirate the cells with 200 μl of RT PBS. Repeat this step twice. NOTE: A 
multichannel pipette is an efficient option for the pipetting steps. 

 
 

4.5. Pipette 200 μl of pre-warmed PBS into each well, wrap the plate in foil and incubate at 65°C 
for 90 minutes to denature endogenous alkaline phosphatase activity. 
 

4.6. Aspirate wells and wash cells in 200 μl of cold (4°C) PBS. Aspirate again, wash in 200 μl of 
cold DDW and aspirate again. 
 

4.7. Pipette 50 μl of the dissolved BCIP/NBT into each well. 
 
 

4.8. Wrap the plate in foil and incubate at RT for 2-24 hours. NOTE: Be consistent with 
incubation time between runs, the time flexibility allows users to photograph wells either 
on day 3 or the following day. 
 

4.9. Using a light microscope camera, take photos of each well using a 4x objective lens, 
ensuring the same exposure, white balancing and light settings are used consistently for all 



7 
 

assays performed.Position each well identically and ensure the edges of the well are not 
visible in the photos. Save photos as TIF format or similar. NOTE: Specific settings will vary 
between microscopes but quantitation will be most effective if the background lighting is 
high and consistent throughout the wells (Figure 1B).   

 

5. Quantitation to determine neutralizing activity using ImageJ 
 
5.1. Download and install the freely available software “ImageJ”: 

https://imagej.nih.gov/ij/download.html 
 

5.2. Open the image to be analyzed in ImageJ ‘File’ > ‘Open’ (Figure 2). 
 

5.3. If using colored images, convert to grayscale by selecting ‘Image’ > ‘Type ’> ‘8-bit’.    
 

5.4. Click ‘Image’ > ‘Adjust’ > ‘Threshold’. Adjust the threshold until all colored areas are 
colored in red, but the background is not. Upon addition of NBT/BCIP, colored product will 
deposit in the area around the cells expressing hPLAP. NOTE: It is recommended to use the 
same threshold setting for all images captured on the same plate. 
 

5.5. Click ‘Analyze’ > ‘Set Measurements’ and tick the ‘Area’, ‘Limit to Threshold’, ‘Area 
Fraction’  and ‘Display label’ checkboxes and click ‘Ok’.  
 

5.6. To determine the signal reading (percentage of coloration) of a given well, click ‘Analyze’ > 
‘Measure’. The ‘% Area’ column of the pop up window displays the signal reading.  
 

5.7. Perform quantitation for all sample replicates. Exclude any wells that are contaminated, 
show uneven cell distribution, or vary in cell density or lighting. See Supplementary Figure 1 
for examples of wells that should be considered for exclusion. Typically, 3-4 wells may 
require exclusion from a 96-well plate. Figure 2 provides a visual representation of the 
quantitation process using ImageJ. 

 

6. Determination of Transduction Inhibition (TI50) titer 
 
6.1. Determine the average readout from replicates (using the steps described in 5) for the: 

• Media only control (baseline signal reading).  
• Virus + media only control (maximum signal reading).  
• Virus + serum samples of interest 

6.2. Calculate the percentage of inhibition using the following formula:                                        
100 - [(Test sample signal readout (virus + serum sample of interest) - baseline signal 
readout (media only control)) / (maximum signal readout (media and virus only) - baseline 
signal readout)) x 100] = % Transduction inhibition.13 
 



8 
 

6.3. Calculate the % transduction inhibition from all replicates of each dilution for all samples 
using the formula in 6.2. Determine the average transduction inhibition between technical 
replicates for each dilution for all samples and controls. 
 

6.4. Calculate the 50% transduction inhibition titer (TI50 titer) of a sample of interest by 
determining the lowest dilution of the sample that yields 50% or greater transduction 
inhibition of hPLAP activity. e.g., if a 1/8 dilution of a sample has greater than 50% 
transduction inhibition based on the calculation performed in 6.2 (and a 1/4 dilution does 
not) report the TI50 titer as 1/8. 

 

7. Determination of neutralized AAV particles 
 
7.1. Calculate the number of neutralized AAV particles per μl of serum for a given sample by 

employing the following formula:  
• ((MOI x cell count/well) / (volume of serum / dilution factor of TI50 titer)) / 2  = 

neutralized AAV particles / μl of serum. NOTE: Dividing by 2 accounts for the TI50 

measuring 50% of neutralized particles. 
 

• For a sample that gives a TI50 titer of 1/4 (25% serum, 75% diluent) in which the 
assay used 80 μl of undiluted serum and an MOI of 15k was plated onto 1x104 cells, 
the following calculation would be used: ((15000 x 10000) / (80/4)) / 2 = 3.75x106 
neutralized particles / μl of serum. 

 

 

 

Representative results  
Transduction assay to establish the optimal viral dosage for plate coverage  

HT1080 cells, a well-established fibrosarcoma cell line, were selected for this assay. A concentration 
of 1x104 HT1080 cells/well provided ~50% cell confluency in each well of a 96-well plate. To 
determine the optimal viral concentration for the assay, a rAAV encoding a hPLAP (human placental 
alkaline phosphatase) reporter gene (AAV6-hPLAP) was added in triplicate at a range of 
concentrations of vg containing particles per cell (MOI: 0, 150, 500, 1500, 5000, 15000, 50000 & 
150000 (Figure 3A)). An MOI of 15000 (1.5x108 vg/well) conferred 36% plate coloration and was 
selected as the optimal viral dosage. A positive correlation was observed between coloration and 
viral concentrations for all MOI between 0 and 15000 (n=6, r=0.995, P<0.001). This concentration 
adequately displayed the reporter gene signal above background in the presence of high 
concentrations of NAbs (low plate coloration), whilst not losing sensitivity due to color saturation in 
the absence of NAbs (high coloration, Figure 3B).  

The efficacy of the assay when exposed to neutralizing elements was trialled using serial dilutions of 
an anti-AAV6 mouse monoclonal antibody (mAb) in triplicate. The standard approach of using the 
first dilution to display 50% or more transduction inhibition (TI50) was applied to determine the 
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neutralizing titer of a given sample (see Methods). Assessing log10 dilutions, the anti-AAV6 mAb 
displayed a TI50 titer of ~10 ng/mL (1 ng total mAb), whilst a concentration of 500 ng/mL (50 ng total 
Ab) and above completely inhibited reporter gene expression (Figure 3C).  

 

Assessment of NAbs against AAV6 in sheep samples 

Serum was collected from the carotid vein using a 16 gauge needle (tip cut-off) and syringe from 
conscious naïve healthy adult sheep (1.5-3 year old Merino ewes) (n=11) and screened to determine 
the TI50 titer using the colorimetric NAb assay. Two-fold serial dilutions ranging from a 1/2 to a 1/512 
dilution were assessed for each serum sample in duplicate or triplicate. The 1/2 dilution contained a 
total of 40 μl of serum, which corresponded to a concentration of 1.88x106 AAV particles per μl of 
serum. The degree of AAV neutralization varied within the naïve sample population, with TI50 titer 
values ranging from as low as 1/2 (blue line) to as high as 1/80 (green line, 1.88x106 to 7.5x107 
neutralized AAV particles/μl serum) (Figure 4A).  

Subsequently, direct cardiac injection (n=5) of AAV6 was performed at doses ranging between 5x1012 
and 3x1013 vg to naïve sheep. Briefly, sheep were anaesthetized as previously described28. The heart 
was exposed from the left lateral position, the pericardium opened and AAV administered via 10-40 
~20μl injections into the left ventricular myocardium (anterior) in the region around the second 
branch of the left anterior descending coronary artery (LAD). The pericardium, intercostal muscle, 
subcutaneous tissue and skin were closed and anaesthetic removed. Serum was collected from all 
animals prior to and six to eight weeks after AAV administration from the pre-cannulated right 
jugular vein using a 16 gauge needle cut-off and syringe (~5ml serum/animal). The colorimetric NAb 
assay was employed to determine the change in NAb titer following AAV6 administration. Post-AAV 
serum samples were screened in triplicate as 2- to 4-fold serial dilutions ranging from a 1/2 to a 
1/32768 dilution. Assay results indicated that AAV inhibition TI50 titer values prior to AAV 
administration ranged from 1/4 to 1/80 (3.75x106 to 7.5x107 neutralized AAV particles/μl serum; 
Figure 4B). Following AAV cardiac injection a clear and consistent contrast in the NAb titer was 
observed compared with pre-AAV serum titers (Figure 4B, Table 3). The lowest AAV dose (5x1012 vg) 
displayed a 1/2048 TI50 titer (dashed blue line, 1.92x109 neutralized AAV particles/μl serum) and the 
remainder of the doses (1-3x1013 vg) displayed TI50 titers ranging from 1/12000 to >1/32768 
(1.13x1010 to >3x1010 neutralized AAV particles/μl serum).  

[Place table 3 here] 

 

 

Figures Legends and Table titles 
Figure 1: Schematic diagram of NAb assay protocol. A) Visual representation of the NAb assay 
illustrating the primary steps involved in the three-day protocol. Briefly, cells are grown and plated 
overnight. The following day, serial dilutions of serum are prepared, incubated with AAV and then 
incubated with the cells overnight. The next day, cells are fixed, washed, incubated, combined with 
substrate and incubated again followed by imaging and quantitation. B) Representative images of a 
minimum signal control (complete AAV inhibition), a maximum signal control (no inhibition) and an 
ovine serum sample with ~50% signal inhibition. Scale bar = 0.5 mm. 
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Figure 2: Steps for determining percentage coloration using ImageJ software. A) Open the image to 
be analyzed with ImageJ software. B) Convert the image to 8-bit grayscale. C) Open the threshold 
window D) Adjust the maximum threshold so all colored areas are covered but background area is 
not (this threshold should be consistent across an entire plate). E) Select the ‘Analyze’ drop box, click 
‘Set measurements’ and tick ‘Area’, ‘Area fraction’, ‘Limit threshold’ and ‘Display label’ and click 
‘OK’. F) Click ‘Measure’ to measure the covered area. The % area indicates the proportion of the 
image that was colored. This can then be used with the control samples to determine the TI50 titer.  

Figure 3: Optimization of viral dose & assessment of assay efficacy against an anti-AAV6 monoclonal 
antibody (mAB). A) Proportion of coloration (% of total area) for individual wells at different 
multiplicities of infection (MOI) and representative images (below) displaying the corresponding 
chromogenic reaction between the alkaline phosphatase (hPLAP) and NBT/BCIP for each viral dose 
(left). Percentage plate coverage is also displayed in tabulated form (right). Each data point 
represents a technical replicate (n=3 replicates per MOI). B) A representation of the correlation 
between coloration and MOI shown in figure 3A. The red dotted line represents the highest 
concentration tested that did not affect the linear correlation between coloration and viral 
concentration.  C) Neutralizing activity against AAV6 from an anti-AAV6 monoclonal antibody at log10 
dilutions. 50% inhibition of AAV6 transduction (TI50) is observed at a concentration of ~10 ng/mL. 
n=3 replicates per dilution. Data represent mean ± SEM. 

Figure 4:  Example of neutralising antibody (Nab) assay results using ovine serum samples. A)  
Adeno-Associated Virus (AAV) neutralizing activity of serum samples collected from 11 naïve sheep, 
measured in 2-fold serial dilutions ranging from 1/2 to 1/512. Colored lines are representative 
samples with low and high neutralizing activity, grey lines represent the other nine samples. The 
dotted line represents 50% transduction inhibition (TI50) and the corresponding TI50 titers for the low 
(blue) and high (green) representative samples. B) AAV neutralizing activity of serum samples 
collected from five sheep before and after receiving a dose of AAV via direct cardiac injection. 
Neutralizing activity assessed in 2-fold serial dilutions ranging from 1/2 to 1/32768. Each color 
represents serum from a different animal, filled lines represent pre-AAV administration and dotted 
lines represent post-AAV administration. n=2-3 replicates per dilution for each sample. Data 
represent mean ± SEM. 

 

Supplementary Figure 1: Visual examples of different reasons for excluding sample wells. A) The 
presence of contamination as can be seen by clumps of in the centre. B) High cell density. C) Uneven 
lighting of well (left image), corresponding thresholding of the same well displaying excess coverage 
in bottom right corner (right image). D) Technical replicate images, image on left representing 
results with normal cell density, image on right reflecting results with low cell density. E) Cells 
unevenly distributed across a well. 

 

Supplementary Figure 2: Simplified plasmid map displaying hPLAP insert. CMV: Cytomegalovirus 
promoter. hPLAP: human placental alkaline phosphatase. SV40: Simian virus 40 polyadenylation 
signal. ITR: Inverted terminal repeat sequences. 

 

Table 1: Volumes of serum and diluent required to generate serial dilutions of serum in triplicate. 
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Table 2: Example 96-well plate layout for assessing naïve serum samples in dilutions ranging from 
1/2 to 1/512. Higher dilutions are incorporated into the assay if assessing a sample known to be 
positive for AAV NAbs (post administration samples) or if a higher titer is required. MO (-C): Media 
only control. VO (+C): Virus and media only control. mAb: Monoclonal antibody against AAV (NAb 
positive control). 

 

Table 3: Impact of AAV exposure on neutralizing activity. Neutralizing activity for sheep assessed 
both before and after receiving direct cardiac injection of a rAAV6 at varying doses. The dose 
received pre and post TI50 titers and fold change following administration are displayed. 

 

Discussion  
This report describes a colorimetric assay which assesses the extent of AAV neutralization in a given 
serum sample by evaluating a chromogenic reaction that corresponds to the degree of in vitro viral 
transduction. The development of the protocol was based on the known chromogenic reaction 
between the enzyme alkaline phosphatase and NBT/BCIP which has been widely utilized as a 
staining tool for the detection of protein targets in applications such as immunohistochemistry, and 
as a reporter tool for evaluating viral transduction24,29-31. Its merit stems from its time and cost 
effectiveness, accessibility, ease of setting up and performing, whilst still demonstrating a high 
degree of efficacy. The rAAV6 employed in this assay (AAV-hPLAP) carries the reporter gene human 
placental alkaline phosphatase (hPLAP) and is driven by a cytomegalovirus (CMV) promoter30 
(Supplementary Figure 2). NBT/BCIP is a hPLAP substrate that is initially dephosphorylated by 
alkaline phosphatase and sequentially undergoes oxidization to form a dimer which results in an 
insoluble product that is a vibrant purple color32.  

In selecting the optimal MOI for this assay, the aim was to establish a viral concentration that would 
provide sufficient expression of the AAV reporter gene through virus-cell binding, and in conjunction 
with the NBT/BCIP substrate, provide coloration within a range that could be accurately measured. 
An MOI of 15000 was selected, as it was the highest concentration tested that did not affect the 
linear correlation between coloration and viral concentration. Higher concentrations (50 000 and 
150 000 MOI) caused the concentration-color response curve to plateau, indicating color saturation 
(Figure 3B). Assessment of viral MOIs between 0 and 15000 (n=6) and their corresponding level of 
coloration resulted in r=0.995 (P<0.001), validating the sensitivity of the assay by establishing a very 
strong positive correlation between viral concentration and reporter-gene driven coloration. Given 
potential variability in factors such as cell culture conditions, laboratory technicians, techniques and 
equipment as well as variations in viral batches, it is recommended that any new user perform a 
preliminary trial assessment of the optimal MOI when establishing a NAb assay. 

The MOI chosen for a given NAb assay is major contributing factor in the overall titer observed for a 
given serum sample. If an MOI of 5000 instead of 15000 had been selected, a 3-fold difference in 
titer value would be anticipated. This has historically been problematic in the field of AAV gene 
therapy, as different pre-clinical and clinical trials have implemented AAV NAb assays with MOI 
values ranging from less than 1000 to as high 2500033, meaning any kind of cross-study comparison 
of NAb titers for a given AAV serotype is of little to no value. It has recently been suggested that 
reporting titers as neutralized AAV particles per μl of serum can provide values that are more 
comparable across different studies9,34. There are numerous other factors that may contribute to 
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variation in titers between studies, such as the choice of cell line, reporter gene, incubation times 
and culture conditions. To facilitate the standardization of AAV NAb assays, both the titer values and 
neutralized AAV particles/μl of serum have been reported. 

It is important to include a serial dilution of a known NAb sample on every plate to act as both a 
positive control and a common sample between plates. This is important to identify any possible 
variability between separate runs. A neutralizing monoclonal antibody against the AAV of interest is 
an ideal positive control and standard, but a serum sample known to be positive for NAbs is also 
acceptable.  The efficacy of the assay was validated by demonstrating that a monoclonal antibody 
specific to intact AAV6 particles (ADK6) can quantitatively inhibit transduction in a concentration-
dependent manner.  

Based on the manufacturer’s material data sheet, the BCIP/NBT substrate system produces the 
insoluble blue-purple product within ∼10 min, and is very stable. However, it is noted that 
procedures may affect the length of incubation time. Based on prior reports, time frames of 1-24h 
have been used35,36. For this assay, it is important that incubation times are consistent between runs. 
The time flexibility, allows users to photograph wells either on day 3 or the following day. 

Preclinical trials using large animal models provide a crucial stepping-stone between the laboratory 
and the clinic due to the physiological resemblance that animals such as sheep and pigs share with 
humans1,37,38. Historically, the vast majority of candidate AAV gene therapies that have made it to 
clinical trials have undergone preliminary trials in large animals1. Multiple studies have 
demonstrated that both humans and a range of large animals including sheep, pigs, dogs, rabbits 
and non-human primates can harbour neutralizing antibodies against AAV6 as well as many other 
AAV serotypes 39,40. This highlights the importance of preliminary screening for NAbs prior to trials in 
both large animal models and humans. NAb status of serum samples from sheep that had no 
previously known exposure to AAV were assessed, of which 10 of 11 displayed TI50 titers <1/30 
(<3x107 neutralized AAV particles/μl serum), whilst one displayed a TI50 titer of 1/80 (7.5x107 
neutralized AAV particles/μl serum). Five of the sheep went on to receive direct cardiac muscle 
injection of rAAV. Amongst all samples, administration of AAV dramatically changed the neutralizing 
activity, with fold change increases ranging from a 125 to a >10,000 fold in TI50 titer values between 
pre and post AAV exposure (Table 3).  Of note, the lowest AAV6 dose administered (5x1012 vg) 
corresponded to the lowest post-AAV TI50 titer value (TI50 titer 1/2000) and fold change increase (125 
fold). While  no clear evidence of pre-existing NAbs within the 11 naïve sheep was observed at levels 
which would prevent AAV transduction (all TI50 titer values <1/100), data from the 5 sheep which 
received a direct injection of AAV would suggest a cut off for NAb positivity would be >1/1000 
(based on pre- and post-AAV values). The stark difference between the pre- and post-NAb titer and 
the capacity to detect titers >1/32,000 provides further validation of the efficacy and sensitivity of 
the assay. Of note, establishment of a cut-point at which a sample is deemed positive for 
neutralizing activity is an important subsequent step when determining a threshold for NAb positive 
animals. This can be determined by assessing the variability in a group (~n ≥30) naïve samples from a 
specific population of interest. This allows for the establishment of criteria to determine a 
statistically derived cut-point in which a sample is deemed positive for neutralizing activity. 
Alternatively, including positive control samples from animals both pre- and post-AAV 
administration, as shown in Figure 4B can provide a clear indication of the positive titer range for 
neutralizing activity. Recommendations regarding the establishment of cut-point thresholds as well 
as validation and optimization of in vitro neutralizing assays have been described extensively in the 
literature41-44.   
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Limitations: The use of the microscope camera to image wells is useful in that it provides very high-
quality images that can accurately differentiate the degree of neutralization. However, microscopy 
can be labour intensive and may not be practical if processing a very large number of samples. The 
use of a high-resolution flatbed or plate scanner may provide a more rapid approach to imaging the 
wells if the quality and lighting of images can be maintained. High MOI’s have been reported to 
reduce assay detection sensitivity and it has been suggested that high AAV doses may be able to 
evade neutralizing activity, or that AAV transduction may occur in the presence of NAbs45-47. This 
assay uses a moderately high MOI (15000), however, the sensitivity does not appear to be impeded 
as it has the capacity to detect neutralizing activity at very high dilutions (>1:32,000) (Figure 4B). 
Lastly, as this assay uses a viral vector, appropriate approval by a governing body is generally 
required to use recombinant AAV, this will differ from country to country. 

In summary, this in vitro assay provides a rapid, cost effective, easily accessible, and simple method 
to detect the presence of neutralizing antibodies against rAAV6. This assay has the capacity to be 
adjusted and optimized to perform with different AAV serotypes with relative ease. The AAV6-hPLAP 
vector can be provided for the purpose of this assay upon request. 
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label
Dilution

3 x sample (240 μL) + 10% 

buffer volume (24 μL)

Ratio of 

serum:media

Dilution 1 (D1) 1/2 264 μL serum 264 μL media 50:50

Dilution 2 (D2) 1/4 264 μL D1 + 264 μL media 25:75

Dilution 3 (D3) 1/8 264 μL D2 +264μL media 12.5:87.5

Dilution 4 (D4) 1/16 264 μL D3 +264 μL media 6.25:93.75

Dilution 5 (D5) 1/32 264 μL D4 +264 μL media 3.13:96.87

Dilution 6 (D6) 1/64 264 μL D5 +264 μL media 1.56:98.44

Dilution 7 (D7) 1/128 264 μL D5 +264 μL media 0.78:99.22

Dilution 8 (D8) 1/256 264 μL D5 +264 μL media 0.39:99.61

Dilution 9 (D9) 1/512 264 μL D7 + 264 μL media 0.2:99.8

Dilution 10 (D10) 1/2048 132 μL D8 + 396 μL media 0.05:99.95

Dilution 11 (D11) 1/8192 132 μL D9 + 396 μL media 0.01:99.99

Dilution 12 (D12) 1/32768 132 μL D10 + 396 μL media 0.003:99.997
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Serum sample #1 Serum sample #2 Serum sample #3

Table 2 Click here to access/download;Table;Table
2_Nab_assay_26_9_21.xlsx

https://www.editorialmanager.com/jove/download.aspx?id=1405175&guid=511d6a64-0b8c-4745-a165-1a8abdbc8caf&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1405175&guid=511d6a64-0b8c-4745-a165-1a8abdbc8caf&scheme=1


9 10 11 12

1/2 50 ng MAb 50 ng MAb 50 ng MAb

1/4 5 ng MAb 5 ng MAb 5 ng MAb

1/8 0.5 ng MAb 0.5 ng MAb 0.5 ng MAb

1/16 MO (-C) MO (-C) MO (-C)

1/32 VO (+C) VO (+C) VO (+C)

1/64
Sample #1 

1/512

Sample #1 

1/512

Sample #1 

1/512

1/256
Sample #2 

1/512

Sample #2 

1/512

Sample #2 

1/512

1/512
Sample #3 

1/512

Sample #3 

1/512

Sample #3 

1/512

Mono AB (mAB), controls and extra 

samples
Serum sample #3



Sheep ID
Administration 

status

Dose 

received 

(vg)

NAb Titer 

(TI50)

AAV 

neutralized / 
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Fold change 

Pre vs Post

Pre-AAV  1/5 5.6x10
6

Post –AAV 1/32000 3x1010

Pre-AAV 1/80 7.5x107

Post –AAV 1/16000 1.5X1010

Pre-AAV 1/16 1.5x10
7

Post –AAV 1/2000 1.9x109

Pre-AAV  1/4 3.8x106

Post –AAV >1/32000 >3x1010

Pre-AAV  1/8 7.5x10
6

Post –AAV 1/12000 2.3x10
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